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Good-bye, hard chewables. Good-bye, JP+ Gummies®.
Say hello to our latest breakthrough product:
new Juice Plus+® Chewables.

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo
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New Vineyard Blend : Six Months to
Chewables coming soon : Sales Coordinator
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(continued from page 1)

Some might call it a revolutionary advance
in nutritional technology. We call it busi-
ness as usual, since we're always working
to keep our Juice Plus+® products on the

leading edge of food science.

New Juice Plus+® Orchard and Garden
Blend Chewables provide you and your
customers the same fruit and vegetable
juice powders as Juice Plus+® Orchard
and Garden Blend capsules - in a tasty
new soft chewable form. You can enjoy
Juice Plus+® Chewables as an alternative
to Juice Plus+® capsules (if you're not a
capsule fan) or as a healthy, whole food
based snack.

Juice Plus+® Chewables is unlike any other
soft chewable or gummi product on the

market today.

e FEach adult serving of Juice Plus+®
Chewables contains only 8 grams of
sugar — and each child serving, only
4 grams of sugar. That's 33% less
sugar than JP+ Gummies®, and 50%
less than our hard chewables. That's
also significantly less sugar than you'd
get from eating an orange. (According
to the United States Department of
Agriculture, a medium orange contains
12.25 grams of sugar.)

*  We've accomplished this by replacing
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corn syrup with two other all-natural
sweeteners - tapioca syrup and

organic cane syrup.

Chewables is 100%

vegetarian; the chewiness comes from

e Juice Plus+®

natural fruit pectins, not gelatin, as
in most other soft chew or gummi
products.

According to taste tests with both
children and adults, we've improved
the taste and the texture of the prod-
uct as well. Our new chewable is soft-
er than our old one — more like a big-
ger gummi — with a texture that was

overwhelmingly favored in our testing.

e We've added almost 2 grams of fiber
to each child’s serving. (That's 4 grams
of fiber for adults.)

New Juice Plus+® Chewables is the same
as old Juice Plus+® Chewables and JP+

Gummies® in two very important ways.

e Like all Juice Plus+® products, new
Juice Plus+® Chewables contains no
artificial flavors, artificial colors, or
artificial preservatives.

*  More importantly, new Juice Plus+®
Chewables delivers the same Juice
Plus+® fruit and vegetable juice pow-
ders as Juice Plus+® capsules. In fact,

two of the new, larger chewables are
equivalent to three of our old gummis
in terms of the amount of fruit or veg-
etable powders that they contain.

Like Juice Plus+® capsules, Juice Plus+®
Chewables helps bridge the gap between
what we should eat and what we actually
eat — every day.

Juice Plus+® Chewables is not just for kids,
of course; but one of the most important
reasons we offer them is to provide added
nutrition from fruits and vegetables in a
form that appeals to the “sweet tooth”
that many of us have — especially children.
If it takes a little bit of all-natural sweeten-
ers to help bridge that nutritional gap,
then that's a dietary trade-off that most
people — particularly parents — are more
than willing to make.

All of your new customers — along with
your existing customers who want to add
new Juice Plus+® Chewables — will begin
to receive the new product immediately.
Your existing Juice Plus+® Chewables and
JP+ Gummies® customers will begin to
receive new Juice Plus+® Chewables
instead of those products starting with
shipments on February 23.

New Juice Plus+® Chewables isn't just better for you and your customers.
It's better for the environment, too.

New Juice Plus+® Chewables isn't just a quantum leap forward in e  reducing total packaging material used by 21%.

terms of what's inside the package. Our new stay-fresh, stand-up ~ ®  reducing total waste by 33 tons a year.

pouches represent a major advance in packaging, too. * reducing plastic waste by 70 tons a year.

Our new stand-up pouches are both attractive and practical. Caring about the quality of the environment outside our bodies

They've helped us hold the line on price, too, despite the many can be just as important in many respects as caring about what we
expensive new ingredients we've added. Our new packaging will  put into our bodies. At Juice Plus+®, we try to have a positive

also have a significant positive impact on the environment by: impact on both.
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Share “new and improved” Juice Plus+® Chewables
with these “new and improved” materials.

For your prospects:
the Juice Plus+® brochure

“Lead with the product” with our basic
Juice Plus+® brochure. It now tells the
story of both Juice Plus+® Orchard and
Garden Blend capsules and new Juice
Plus+® Orchard and Garden Blend
Chewables.

We've added a whole new Chewables
section to our previous brochure — so that
you can offer new Chewables as an alter-
native to capsules for potential Juice
Plus+® customers of all ages who prefer
a 100% vegetarian option, or simply have

trouble swallowing capsules.

(Sold in packs of 40 for $6.00)

cise more, and reducing stress. It also
helps acquaint them with our other Juice
Plus+® products in the process.

The Guide to Better Health has now been
updated to include new Juice Plus+®
Chewables - so that you can offer new
Chewables as a healthy snack for existing
Juice Plus+® customers of all ages, in
addition to Juice Plus+® capsules.

(Sold in packs of 25 for $12.50)

For your customers:
The Juice Plus+® Guide
to Better Health

These and other Juice Plus+®, Juice Plus+®
Virtual Franchise®, and Juice Plus+®
Children’s Health Study materials are
available through Promo Plus+ at
www.nsapromoplus.com or by
calling 888-552-8200.

Our Juice Plus+® Guide to Better Health is
a simple guide to the complete Juice
Plus+® health and wellness experience. It
encourages your Juice Plus+® customers
to take additional steps toward leading a
healthier lifestyle — including eating better,

drinking more water, finding ways to exer-
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Coming in 2010: “Juice Plus+® Effect”
Customer Retention Program
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One of Juice Plus+® Marketing’s best-kept
secrets is likely to start catching on in a

big way in 2010, thanks to some important
changes. The Juice Plus+°® 90 Day Fitness
Effect — which has been in test mode since
late 2008 — will be expanded to focus

“not just on exercise, but also on the
entire Juice Plus+® experience,” says Juice
Plus+® Director of Marketing Melissa
Brady. “We're going to rebrand the pro-
gram The Juice Plus+® Effect — and
encourage our people to use it to help
them retain even more of their customers.
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“"We'd obviously like for everyone to exer-

cise in addition to taking Juice Plus+®,”
Brady continues, “but we also want them
to eat better, to drink more water, and to
find ways to reduce the stress in their lives.
And, as Jay Martin points out so often,
taking Juice Plus+® serves as a catalyst to
these kinds of broader lifestyle changes —
not vice-versa. Trying to encourage seden-
tary people to start an exercise program
at the same time they start taking Juice
Plus+® could fly in the face of that sound
advice.”

Brady advises that the Juice Plus+® mar-
keting team is working on a significant
repositioning of the program - including

a new brochure and a re-work (and
re-naming) of The Fitness Effect DVD. “In
the meantime, people can use The Juice
Plus+° Guide to Better Health [see page 3]
as a support piece for the program. It
describes both Juice Plus+ Vineyard
Blend® and Juice Plus+ Complete® in full
detail — and scores exactly the same points
as The Fitness Effect DVD."”

Brady points out that the 90 Day Fitness
Effect program has been a huge success
in terms of achieving its primary goal:
improving customer retention. “It's work-
ing just like we thought it would,” she
elaborates. “New Juice Plus+® customers
exposed to the program complete the sur-
vey after 90 days, select which additional
product (Juice Plus+ Vineyard Blend® or
Juice Plus+ Complete®) they want to try
for free, and then accept that second car-
ton of Juice Plus+®. On the business side,
our representatives get over that second-
carton 'hurdle’ — and introduce an addi-
tional product to their customers without
having to ‘make a sale.””

The results speak for themselves: 99%

of the people who complete the survey
accept that second carton of Juice Plus+®
—and 84% accept the third.

“The only problem has been that the
emphasis on fitness has complicated our

“The program has been a huge success in terms of retention: 99% of the people who complete

the survey accept that second carton of Juice Plus+® — and 84% accept the third!”
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point of sale — and scared many of our
representatives away from even trying
the program. They know that it can be
challenging enough sometimes to get
their family and friends to start taking
Juice Plus+® — let alone try to get them
to commit to an exercise program on
top of that.

“We're certainly not abandoning our
emphasis on exercise as a key compo-
nent of a healthy lifestyle,” Brady
stresses. “But starting to exercise regu-
larly is easily the toughest health-relat-
ed challenge of all for a lot of people.
And Juice Plus+® has always been
about helping people get healthier by

meeting them where they are.”

As evidence, Brady points to the U.S.
Centers for Disease Control and
Prevention 2008 National Health
Interview Survey, which reports that
three out of every five adults 18 years
of age and over never engage in any
“vigorous leisure-time physical activity”
at all. "And it's even worse for women,”
she adds. “Almost two-thirds of us

never exercise.

“One of the key reasons for the success
of Juice Plus+® is that sedentary people
who eat poorly see it as an ‘easy’ first
step to take. We certainly don't want

to scare those people away by telling
them they have to immediately start to
exercise. They need Juice Plus+® more

than anyonel

“In the final analysis,” Brady concludes,
"we expect we'll actually get many
more people to
start exercising —
and we'll certain-
ly be helping our
Juice Plus+® rep-
resentatives get
them to continue

taking Juice

MELISSA BRADY

Plus+® longer.”
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WHAT IS THE
BASIC PROGRAM?

It's still our tried and proven system of

sharing Juice Plus+®, with an “added

twist” that's designed to help you:

attract new Juice Plus+® customers

by offering a free product incentive.

reinforce your new customer’s com-
mitment to a second carton of Juice
Plus+® by walking them through a brief
telephone survey to make them stop
and consider what their first 90 days on

Juice Plus+® has really done for them.

Survey questions are related to such
topics as diet, energy, and sleep; and
help you focus your customer’s atten-
tion on the positive impact of his or her
initial Juice Plus+® experience. A copy
of the survey is available in your Virtual
Office
Materials>Juice Plus+® Fitness Effect.

under Tools>Juice Plus+®

allow your customers to try their
choice of Juice Plus+ Complete® or
Juice Plus+ Vineyard Blend® without
your having to ask for the order.

We give every customer who com-
pletes the telephone survey his or her
choice of either a free two-month sup-
ply of Juice Plus+ Vineyard Blend® (two
bottles) or a free 30-serving supply of
Juice Plus+ Complete® (two cans) —
more than a $50 value — along with
their second carton of Juice Plus+®
capsules or chewables. We cover the
entire cost of the free product except
for a $5 contribution that is automati-
cally deducted from your $20 retail

profit on that second carton.

JUICE PLUS+° VIRTUAL FRANCHISEE

HOW DOES IT
BENEFIT YOU?

It provides an added incentive for your
prospect to purchase Juice Plus+® ini-
tially — and, later, to look forward to

that second carton.

It gives you another reason to stay
engaged with your new customer dur-

ing those critical first 90 days.

It introduces Vineyard and Complete,
without your having to “make a sale”
and ask for extra money. In fact, your
customer gets more than $50 worth of
product absolutely free (with no ship-
ping and handling charge).

It's easy to implement. You simply
share Juice Plus+® as you normally do:
there is nothing to sign on the front
end, and there are no special forms to
fill out.

It's easy for your customers, too. All
they really have to do is answer a few

questions and select their free product.
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Juice Plus+® Product News

Juice Plus+ Vineyard Blend®
Chewables is coming!

How could we possibly top new Juice
Plus+® Orchard and Garden Blend
Chewables? By following them up quickly
with new Juice Plus+ Vineyard Blend®
Chewables!

We're already in the final stages of apply-
ing our great new Chewables technology
to our popular Juice Plus+ Vineyard
Blend® product. Soon, all three of our
Juice Plus+® juice powder blends will be
available to you and your customers in

tasty, “soft chewable” form.

Juice Plus+ Vineyard Blend® Chewables
will offer the same basic benefits as

Juice Plus+® Orchard and Garden Blend
Chewables, including a 100% vegetarian
pectin base and the use of all natural
sweeteners (and no corn syrup). And
they'll be delivered in the same, more
environmentally friendly stay-fresh

pouches as well.

Stay tuned for updates on when this excit-
ing new Juice Plus+® product line exten-

sion will become available.

%ﬁh _
\COM PLETE

s

Dt

New look for
Juice Plus+ Complete®

Beginning sometime in early 2010, Juice
Plus+ Complete® will be delivered to you
and your customers in the attractive new

packaging pictured below.

This new packaging makes Complete
visually consistent with the rest of our
Juice Plus+® product line — by giving it a
“look” that's similar to our Juice Plus+®
Orchard, Garden, and Vineyard Blend
packaging. To reinforce the whole food
based positioning of Juice Plus+
Complete®, we feature a vanilla bean

on French Vanilla Complete and a cocoa

bean on Dutch Chocolate Complete.

Al other aspects of the product’s packag-
ing — as well as the product inside —

remain unchanged.

Juice Plus+® product line
becomes more focused

These changes are part of an effort to
improve the focus of our Juice Plus+®
product line in order to be more consistent
with the whole food based positioning

of the Juice Plus+® brand.

The changes include:

®  The replacement of our old "hard
chewable” product and JP+
Gummies® with new Juice Plus+®
Orchard and Garden Blend
Chewables.

e The introduction next year of new
Juice Plus+ Vineyard Blend®
Chewables.

*  The repackaging of Juice Plus+®
Complete, as pictured here.

e The discontinuation of two products
that no longer fit with the rest of our
product line: Juice Plus+® Thins and
Juice Plus+® for Dogs and Cats.

“The fact that Juice Plus+® Thins was
formulated as a weight loss product is
problematic,” John Blair, Vice President of
Research and Development, explained to
Juice Plus+® National Marketing Directors
at our recent Fall Leadership Conference
in Memphis. “Not only is that off-strategy,
but it's also a product positioning that reg-
ulators are particularly sensitive to and
skeptical of. We simply can't justify taking
that kind of risk for a product that rep-



resents less than one percent of our

business.

"Juice Plus+® for Dogs and Cats is an even
more extreme case,” Blair continued. “It's
completely off-strategy for us — we're in
the business of human health and nutri-
tion. Further, the dog and cat products
generate even less revenue than the

Thins do.

“It has nothing to do with the quality of
these products,” Blair concludes. “We
know we have a small number of loyal
customers for these products, and we're
sorry to disappoint them. But we have to

consider the greater good.”

Al of these changes (except for the intro-
duction of Vineyard Blend Chewables, of
course) have already been reflected on
your personalized Juice Plus+® website, on
JuicePlus.com, and on all customer order
forms. The discontinuation of Juice Plus+®
Thins has also been communicated to

those customers who are affected.
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NSA continues to support
Juice Plus+® clinical research

NSA has invested millions of dollars over
the years to encourage and support inde-
pendent, third-party clinical research on
Juice Plus+® by top researchers at leading
hospitals and universities around the
world. It's something that we're very proud

of — and that you can be, too.

We occasionally get questions about this
practice, however. So we turned to Anita
Boddie, Ph.D. — our Director of Juice
Plus+® Clinical Research — for some

answers that you can share.

“First of all, this is hardly some 'big
secret,’” she laughs. “We're very open
about it, and so are the academic institu-
tions involved. Declaration of the source
of funding is a standard requirement for
academic publication, including all of the
medical and scientific journals publishing

studies on Juice Plus+°.

“In addition, people need to understand
that funding for the vast majority of all
published research — both in the United
States and around the world — comes from
sponsored projects,” Dr. Boddie explains.
“Most universities maintain offices dedicat-
ed to sponsored projects. For two examples,

check out Cornell (www.osp.cornell.edu)

900 000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000
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and Georgia Tech (www.osp.gatech.edu).
Your state university will have a similar
office — though it may or may not have

a website.

"When any research project is sponsored
at an academic institution, a contract for
the clinical project is executed between
the sponsoring organization and the uni-
versity,” Boddie elaborates. “The researcher
works for the university; and the sponsor
pays the university directly, to ensure that
the researcher is independent from the
sponsor. In fact, university faculty often
have several projects funded from various
sources underway at once — and usually
have no personal interest in any of them
other than advancing scientific knowledge

and having a publishable paper in the end.

“Finally, once the investigation is com-
plete, the results are reviewed by medical
and scientific peers at the ‘peer reviewed'’
journals in which they are published,”
Boddie continues. “Obviously these peo-
ple have absolutely no personal interest in
either the study or the sponsor other than

ensuring the validity of the science.

“All'in all, it's an extremely rigorous
process,” Boddie concludes. “The idea
that we would, or even could, somehow
influence the outcome of these investiga-
tions on Juice Plus+® is completely ill-
informed — not to mention an affront to
the scientists who conduct the research; to
the institutions that oversee the efforts of
those scientists (and attach their names
and reputations to them), and to the aca-
demic peers at the journals who review the

studlies prior to publication.
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Jay Martin Answers Your Questions

What do handcuffs,

a shower curtain, and

the minor league baseball
team in Pocatello, Idaho
have to do with the

Juice Plus+® business?

Ask Jay Martin. At our
recent Fall Leadership
Conference in Memphis,

he shared his answers to
several questions that

he often gets in his
appearances around the
country, as well as to ques-
tions submitted to him from
our Juice Plus+®Connections
blog in the Virtual Office.

We share some of

his answers here.

s

JAY MARTIN

What is your feeling on additional
Juice Plus+® product line extensions?

“That's an area in which we need to be
very careful. Focus is one of the most sig-
nificant things that has contributed to our
Juice Plus+® business growth. Leading
with a single product — Juice Plus+®
Orchard and Garden Blends - is key to
that focus. Being able to tell one story —
one simple story — and to not have to
learn about and explain a bunch of differ-
ent products has been key to our success.
So our position is to be very careful in

terms of product line extensions.

“Any product that we do add has to meet
certain criteria. It cannot confuse our sim-
ple, single-product point of sale. It has to
be unique. It must be consistent with our
whole food positioning and message. The
price point and the profit margin have to
be good for the customer, for us, and for
you. And it has to clear an incredible num-
ber of international and regulatory and sup-
ply chain hurdles. So it's not as easy as it
sounds to introduce a new product, even

when we want to.

“Despite these challenges, we don't put
our heads in the sand. We have an active
product development effort that has led
most recently to the introduction of our

exciting new Juice Plus+® Chewables

product. But any time we extend our
product line beyond what it is now, you
can rest assured that it has been done in a

very careful and well-thought-out manner.

What about international
expansion?

“We look at that very carefully, too. We
already sell Juice Plus+® in most of the
industrialized world, and we're not on
some corporate ego trip of trying to just
put pins on a map. So we generally like to
support and focus on the areas that we

already do business in.

“Once again there is a long list of criteria
that has to be considered, including the
regulatory environment, distribution chal-
lenges, the size of the middle class, and

various cost and pricing issues.

“We are looking into new markets in Asia
— China and South Korea, for example. But
basically, we're very conservative in terms
of international expansion. Just like poten-
tial additions to the product line, any inter-
national expansion we do embark upon is
going to be done in our very careful, con-

servative way. ”
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“‘Thank you’ is the simplest form of recognition that you can give.”

Can you give us some tips on
motivating our Juice Plus+®
team members?

"We used to use a three-part program
years ago called Contact, Competition,
and Recognition. It still has merit in our
business today.

“First is Contact; you can't motivate any-

body if you don't stay in touch.

"I had a guy out in North Carolina when |
first got started in sales who used to say,
‘When | hire somebody, I'm going to stay
in contact with them. | may not actually be
there, but when they go to the bathroom
in the morning they need to at least think |
could be behind their shower curtain.” So
you've got to bug ‘em; you've got to stay

with ‘em.

“"We used to say that you never turn
somebody loose until they've seen ink
strike paper. In other words, that first ‘sale’
is very important. If your team member
gets rejection right out of the gate, and
you're not there to help them, their Juice
Plus+® career can be over in 72 hours. You
cannot let that happen. You work too hard
to sell them on Juice Plus+® and then to
bring them onto your team. You need to
help them make something positive hap-

pen before you turn them loose.

“You also have to establish regular contact
with people. If at all possible that has to
include some face-to-face time. If they live
in Timbuktu that can sometimes be a little
hard to do, but you've got to establish a

way to stay in contact with your people on
a consistent basis. Remember, when they
go to that bathroom, they need to think
you might just be behind that shower

curtain.
“Second is Competition.

“| think that we sometimes miss the boat a
little bit with competition because we have
a tendency to let people compete against
themselves, when they are probably going
to do better if they compete against

someone else.

“A classic example of this is the breaking
of the four-minute mile barrier. During the
1950s, Roger Bannister became the first
person in the history of the world to run a
four-minute mile. For centuries runners had
tried to achieve that milestone, but
Bannister was the first to do it — and he
accomplished that goal by running against
someone else. Aimost immediately after
Bannister did it, there were others all over
the world who ran four-minute miles — but
it was several years before anybody ever
ran one alone, without someone to com-
pete against. So competition in our busi-
ness — like any other business — is extreme-
ly important. It really is a fueling factor in

terms of success.

“As Juice Plus+® team leaders, you need
to find every way you can to create a com-
petitive environment and get members of
your team — including yourself — in some
type of competitive situation with some-
body else.

“The third ingredient is Recognition.

“It's ‘Daddy, watch me!” We are born want-
ing to be acknowledged for whatever it is

that we accomplish. We want somebody

to brag to (as well as somebody to cry to).
We want to be able to walk across a stage
to applause — or just to have somebody say
“thank you.’

“I think this need for recognition starts with
the customer. One of the best tips | could
give you is that when you ‘sell’ someone
on Juice Plus+® you need to take some
time to thank them for their decision — and
tell them you know that they have made
this decision largely because of you, and
how much you appreciate that fact. ‘Juice
Plus+® is not going to let you down and
I'm not going to let you down. | may bug
you a little bit, but I'm going to make sure
that you get your money's worth, because |
appreciate your confidence in me and your
trust in me.” | can't think of a better way to
start a relationship.

"People are starved for recognition, and
“thank you' is the simplest form of recogni-
tion that you can give.”

What is the best “tool” to use to get
somebody to an event?

"That's real simple: handcuffs. You need to
strap them to your arm, they need to ride
in your car, and they need to show up

locked hand and arm to you.

"Have you ever invited someone to a
meeting who didn't show? Have you ever
brought someone to a meeting who didn't
show? | mean, that is the difference.”
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“Have you ever invited someone to a meeting who didn't show?
Have you ever brought someone to a meeting who didn't show?”

How has the economic slowdown
affected our business?

| don't believe I've ever seen as severe
an economic situation as this one. It has
affected us somewhat, but really very little
overall. We've had some minor issues with
credit cards and suppliers and those types

of things.

"l was at a CEO conference in New York
recently and there were about 25 of us
there. | think our company ranked second
in terms of how well we had done. We all
asked the guy that ranked first how he had
done it — he was in the airplane parts busi-
ness. He said, 'Well, before you get too
excited, two of my competitors went

under, and | picked up their accounts.’

"So, in short, our current situation is solid
as a rock and much better than most. We
are investing as others are retreating.
We're improving our product line. We're
expanding internationally. We're adding
youth and depth to our management
team. We're offering added incentives to
you in the form of Team Building Bonuses
- and paying for them with our own
money. And we're in the strongest cash

position we've ever been in.

“Today, more people than ever are looking
for a financial Plan B that can lead to a
Plan A. We could not be better positioned
to take advantage of that.”

Healthy Life

NEXT EXIT

How do you see the current
initiatives regarding healthcare
reform affecting our business
and, more specifically, our NMD
benefits package?

“I've been around a while and | don't
believe I've ever seen as much animosity
in a public policy debate as | have seen in
the effort to reform our healthcare system —
maybe during the Vietnam War. | liken it
to Monday Night Wrestling Raw — or to

a Baptist church trying to get rid of a

preacher that doesn’t want to go.

“But there is one element of agreement
among just about everybody: that if we
don't do something on the prevention side
of the equation, any healthcare system we
come up with is eventually going to go
bust. Since that's what Juice Plus+® is all
about, we could not be better positioned
to take advantage of the growing interest

in and concern about healthcare.

“| certainly see nothing in any of the cur-
rent healthcare proposals that would affect
our NMD benefits package one iota. It's
not only one of the best in our industry but
also one of the best in corporate America

—and we plan to keep it that way.”
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How do you deal with
disappointment?

“I think first of all you've got to realize it's

going to happen.

"One of my favorite movies of all time is
Oh, God with George Burns. | remember
when he was on the witness stand and he
was asked, ‘Why is life so unfair? Why are
some people born with sickness and some
born with health; some born in poverty
and some born with wealth?’” George
Burns thought a minute and said, "Well,
when | made this world, | thought | did a
pretty good job, and I've gotten a lot of
compliments over the years. But you know,
there were certain things that | just could
not figure out. | couldn’t figure out how to
make a front without a back. | couldn't fig-
ure out how to make a top without a bot-
tom. And | couldn’t figure out how to
make an up without a down.” So the first
thing in dealing with disappointment is
that you've got to know that disappoint-

ments go hand-in-hand with successes.

“I think the second thing in dealing with
disappointment is that you've got to look
beyond the moment toward a higher
purpose, keep your eye on the prize —
and never lose sight of the bigger goal

in front of you.

"My high school baseball coach Burley
Simmons played minor league baseball
before coming back to his hometown and

becoming the baseball coach and town
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“Today, more people than ever are looking for a
financial Plan B that can lead to a Plan A.”

policeman. We were absolutely amazed at
how good he was. | mean, he could throw,
he could hit, he could field — and he could
play just about any position.

“One of my buddies asked him, ‘Burley,
how come you never made it to the big
leagues?’ Burley said, "Well, boys, it's pret-
ty simple: old Burley couldn't hit a curve
ball. When you get to AA Pocatello, you
find that out — and it ain‘t long until you're
back down in C ball.’

“"You boys are going to have some curve
balls thrown at you in life — and if you can't
hit ‘em, you can't play in the big leagues;
you'll always be stuck in Pocatello.” Our
business is going to throw you some curve
balls, too — and if you can't hit ‘em, you're

going to be stuck in Pocatello.

“So, to summarize, you're going to have
to deal with disappointment, so you've
simply got to learn to hit those curve balls;
and you've just got to keep looking at that
goal of the big leagues that is out there in
front of you.”

What one piece of advice would you
give me to help me succeed in my
Juice Plus+® business?

“| think that all of you who have heard me
before know what that is: to reach your full
potential in our business, you need to find
a partner. It's got to be somebody who's in
tune with what you're doing. It can be your

spouse, your friend, the first customer you
attracted to your business — but you need
somebody to work alongside you, simply

because it's harder to go it alone.”

e

Apart from building a business that
has helped thousands of people all
over the world realize their dreams,
what about our company are you
most proud of?

“Well, that's a tough question, because I'm
so proud of so many things that we've

been able to accomplish over the years.

“Certainly one thing is seeing so many
people in our business develop so much,
in terms of personal growth. That's some-
thing that we can all be proud of. I've seen
people who used to be mortified at the
thought of talking in front of two or three
people speaking in front of hundreds (or
even thousands) of people. I've seen peo-
ple who have never had the opportunity to
travel all of a sudden traveling all over the
country or even all over the world to visit
friends they've made in our business. And
I've seen people make friends that they
would otherwise have never made in a

million years.

“But | was recently reminded — as | am
time and again - of easily the best answer
of all to this question. | was at our
European conference in Venice, ltaly, sit-
ting backstage with National Marketing
Director Wendy Campbell. She started
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talking about how she felt about what we
do to educate and motivate people to
take control of their health. And then Dave
O'Brien from Ireland walked in and talked
about the fact that he and his father had
just done a tour of 40 schools in Ireland
talking to kids about nutrition.

"We have helped literally hundreds of
thousands of people — and not just Juice
Plus+® customers — become more aware of
what a healthy lifestyle really means, and
how simple it can be to start taking impor-
tant steps in that direction.

“That is what I'm most proud of.”

One of the highlights of every Juice Plus+®
Leadership Conference is the Friday morn-
ing keynote address by our President and
Founder Jay Martin. For information about
our upcoming Leadership Conference in
Phoenix, Arizona, turn to page 20 of this
issue of the Juice Plus+® Virtual

Franchisee.
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NEW “SIX MONTHS TO SALES COORDINATOR"
PROGRAM PROVIDES FASTER TRACK TO THE TOP

Our "10-1-10" plan helps your new Juice Plus+® team  program helps those same new team members con-

members get off to a fast start in the Juice Plus+®
business — by helping them reach the Virtual
Franchisee position in their first 60 days. Now, our

brand new "“Six Months to Sales Coordinator”

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

tinue their early business momentum — all the way to
Sales Coordinator — by following our ongoing “5-1"
plan for the next four months and getting their new

team members to follow “10-1-10."

HOW DOES “SIX MONTHS TO SALES COORDINATOR"” WORK?

In effect, it exchanges time and team
structure for money - by allowing
your new team members to earn the
Sales Coordinator position and its
22% commission with a lower busi-
ness requirement (“Purchase Volume
Credit,” or PVC). But they have to
meet the new requirements during

their first six months in the business.

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

"Regular”

Requirement

Sales Coordinator
(22% commission)

New “Six Months to
Sales Coordinator”
(22% commission)

PVC 12,000 8,000
Time none 6 months
Team structure 3 “lines” 3 “lines”

3 Direct Distributors

2 Virtual Franchisees*
1 Direct Distributor

* at least one of the two must be “10-1-10"

ARE THERE ADDITIONAL INCENTIVES INVOLVED?

Yes. In addition to being able to earn
the 22% commission that all Sales
Coordinators receive, individuals
who successfully complete our

“Six Months to Sales Coordinator”
program will receive these additional

benefits.

+

An additional $500 bonus - plus
a $500 bonus for his or her
sponsor.

A personal “Corporate Business
Partner” to work with one-
on-one.

A free ticket to an upcoming
Juice Plus+® Leadership
Conference.

12

Our 2010 Spring Leadership
Conference is being held April
22-24 in Phoenix, Arizona.

Our 2010 Fall Leadership
Conference is being held
October 21-23 in Nashville,
Tennessee.
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WHAT IS THE “10-1-10" PLAN? WHAT IS THE “5-1" PLAN?
The “10-1-10" plan is designed to help build early The “5-1" plan is designed to build continuous,
business momentum right out of the gate. ongoing business momentum by hitting the “5-1"

goals every month after you reach the Virtual

Franchisee position.
+ Find 10 customers.

+ Find 1 other person to join your Juice Plus+° :
team. + Find 5 additional customers of your own every

month.
+ Find 10 additional customers - either from

yourself or from your new team member. + Find 1 other person to join your Juice Plus+°®
: team every month - and start to duplicate

10-1-10 and 5-1 with them.

Anyone who completes this simple 10-1-10 plan
within 60 days of entering the Juice Plus+® business

earns the position of Virtual Franchisee (VF) and its Under our Team Building Bonus program, represen-
14% commission. tatives who complete the “5-1" goal earn an addi-

tional $100 bonus the first month they do so and

Under our Team Building Bonus program — which $200 for each consecutive month thereafter.

has now been extended through April 30, 2010 (see

page 20) — new representatives who achieve 10-1-10 By continuing to follow the “5-1" plan for the next
also receive an additional $250 Team Building Bonus four months after earning the Virtual Franchisee
plus a free ticket to a Juice Plus+® Leadership position using “10-1-10,” your new team members
Conference. Their sponsors also receive a $250 should be able to achieve the Sales Coordinator
bonus. : position in six months.

WHAT IF I'M NOT NEW TO THE
BUSINESS, BUT I'M READY TO GET

TO WORK - OR HAVE A TEAM MEMBER
WHO IS READY TO GET SERIOUS
ABOUT THE BUSINESS?

If you're serious about re-energizing your Juice Plus+®
business, there are ways for you to take advantage of
these “fast track” programs. For more information,
please talk to your sponsor or Juice Plus+®
Distributor Support (Support@JuicePlus.com).

13
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Your Juice Plus+® Virtual Office

just keeps getting better — and better!

We've “rebranded” your online Virtual Office to be the
Juice Plus+® Virtual Office — complete with a new
Internet address (JuicePlusVirtualOffice.com)

that automatically “redirects” from the old one.

Besides improving the look and updating the graphics of the
website, we've made a number of other, more substantive
changes that make managing your Juice Plus+®

business easier than ever before.
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A redesigned home page

The home page of your Juice Plus+®
Virtual Office has been completely reor-
ganized for greater ease-of-use. It puts the
key information you need to manage your
Juice Plus+® business — including My
Alerts, Team Building Bonus, News, My
Calendar, and even Quick Links to other
key forms and features in your Virtual
Office — right at your fingertips.

Easier access to
Juice Plus+® Connections

Juice Plus+® Connections is the informa-
tive new business blog that growing num-
bers of Juice Plus+® representatives are
taking advantage of — to learn more about



Juice Plus+® and the Juice Plus+® Virtual
Franchise®. You can send in your own
questions to Connections or read ques-
tions, answers, and comments from others
— all within the safe, non-public confines of

your Virtual Office.

Now, direct links to Juice Plus+®
Connections, including links to a “featured
article” and the three most recent
Connections posts, are featured right on
the home page of your Virtual Office.

New, improved Juice Plus+®
Memory Jogger

Your Memory Jogger is one of the most
indispensable tools of the Juice Plus+®
business — not only for new representa-

tives, but also for “veterans,” too.

Now, when you enter new information into
the online Memory Jogger form, there is
no need to re-enter the same information
elsewhere on the website; that same infor-
mation is also added automatically to your
address book.

You can find your online Memory Jogger
under Training >Starter Guide >My
Memory Jogger.

2009

December

New interactive online
Starter Guide

Now you and your new team members
can complete not only the Memory Jogger
form, but also all of the other forms includ-

ed in our Starter Guide directly online.

The information that you enter is saved
automatically to your computer, your
Virtual Office Address Book, and/or My
Calendar, as appropriate.

15
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Enhancements to My Calendar

You are now able to distinguish between
different types of activities on My Calendar
by “color coding” them. Also, specific
events that you add to My Calendar now
include both the name of the speaker and

the address of the event.

We've made a number of other changes
designed to help you squeeze the most
out of the time you spend on your Juice
Plus+® business.

In fact, we've made so many improve-
ments — large and small — that they are too
numerous to mention here. There's a new
Online Sponsor Checklist, new and
improved Address Book capabilities, new
reports and reporting features, new email
enhancements — even several improve-
ments specifically designed for Wellness
Coordinators in our Professional Support
Program. And the list goes on.

For a more comprehensive look at every-
thing that’s new and different in your
Juice Plus+® Virtual Office, go to
Training>Presentations and download
The New and Improved Juice Plus+®
Virtual Office from our recent 2009 Fall
Leadership Conference in Memphis.
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Juice Plus+® is a “social networking” WHAT IS FACEBOOK?
business. Facebook is a “social networking” Facebook is far and away the world’s most
website. More and more, Juice Plus+® popular social networking website, with

more than 350 million active users. These

representatives are using Facebook to help them o .
aren't just “idle” numbers, either: 50% of

re-connect (and stay connected) with their “warm markets” — these people log on to Facebook on any
and build their Juice Plus+® businesses in the process. given day. It's also the world's fastest-
growing social networking website —
You can, too. having added more than 100 million

users just between our two most recent
Juice Plus+® Leadership Conferences in
March and October, 2009!

Interestingly, the 35+ age demographic is
the fastest growing segment of Facebook.

16
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WHY IS FACEBOOK SUCH A GREAT FIT
FOR THE JUICE PLUS+® BUSINESS?

HOW DO YOU GET INVOLVED WITH
FACEBOOK IF YOU HAVEN'T ALREADY?

SOME “DO’S” AND “"DON'TS” OF
SHARING JUICE PLUS+°ON FACEBOOK

Facebook is a great fit for our business 1) Set up your own personal Facebook DO realize that Facebook is a friendly,
because it’s all about relationships — just page. Most people find it easiest just  social place — not an online marketplace
like the Juice Plus+® business. to go to Facebook.com and follow the  for doing business with people.
. directions there. If you prefer a more ) ) )
e Growing numbers of people you ) DO take a little time to get acquainted and
step-by-step approach, you can find )
know are on Facebook, as you can e ) comfortable with Facebook on a purely
. specific instructions under Resources at )
see from the numbers we just shared ) ) ) ) personal level before you start trying to
. Juice Plus+® Connections in your Juice ) ) )
on the previous page. ) . use it as a Juice Plus+® business tool.
Plus+® Virtual Office.
e It's like an online Memory Jogger DO look for opportunities to quietly brin
4 . 99 2) Become a "fan” of the official : PP quiety ] 9
that helps you re-connect with old . up the issue of health and wellness with
. . Juice Plus+® Facebook page at o )
friends and acquaintances you may . your growing list of Facebook friends —
www.Facebook.com/JuicePlus. Even
have forgotten about. Once you have . once you have become comfortable.
, though we just started our Facebook , ,
a Facebook page, these people will be (It won't take long.) That's what so many
i +— and heloi page a few months ago, we already ther Juice Plus+® | doi
seeking you out — and helping you con- other Juice Plus+® people are doin
9y pingy have over 13,000 fans — almost three peop 9
nect with other people, too. ) ) successfully — and you can, too.
times more than direct sales compa-

* It's a great way to stay connected nies NuSkin and Amway combined. DON'T bring up Juice Plus+® to anyone
with people you know, including your The official Juice Plus+® Facebook  without making it clear that you are a Juice
prospects and customers. In addition page features various product-related  Plus+® representative.
to its many other uses, Facebook has resources, including links to videos and ) ]

. . . _ DON'T make being a Juice Plus+® repre-
become the world’s largest photo interesting nutrition-related articles, } .
. , sentative appear to be your primary reason
sharing site. that you can share with your Facebook i
friend for being on Facebook. Instead, focus on
riends.

e It's “simple and duplicatable.” being the person you are both inside and

Anyone can set up a Facebook page, 3) Start connecting. You'll quickly begin  outside the Juice Plus+® business — mother,

quickly and easily; and it's easy to

"keep up with” thereafter.

to receive requests from people you
know who want to “friend” you — and

you can start looking to do the same.
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doctor, teacher, etc. That's much easier for

people to identify with.

DON'T ever try to make the Juice Plus+®
“sale” online — on Facebook or anywhere.
Facebook is a good place to plant the

seed or start the conversation, but always
handle the follow-up conversation offline,

one-on-one.

DON'T “lead with the business” on
Facebook. Never forget that while 100%
of your Facebook friends should be inter-
ested in Juice Plus+®, only 5-10% are likely
to be interested in having a business of

their own.

DON'T confuse the additional time you
spend having fun on Facebook with time
you've allocated to building your Juice
Plus+® business. Interacting with your
friends on Facebook can become some-

what addictive if you're not careful.
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Direct Deposit:
good for the environment -
and now even better for you

December 2009

There are already so many advantages to converting your

Juice Plus+® check to direct deposit — and letting us

automatically deposit your check directly

into your bank account each month.

Having your Juice Plus+® check automati-

cally deposited has so many benefits.

YOU GET YOUR MONEY FASTER.
We automatically deposit your check no
later than the 10th of each month, the
same day we mail it to people not taking
advantage of Direct Deposit.

IT'S EASIER. You won't need to check
your mailbox every day to see if your
check has arrived. You won't need to call
us to find out when it was mailed. You
won't need to drive to the bank to deposit
it. And you won't need to make special
arrangements to have it deposited when
you're out of town. You simply check
online on your own private, password-pro-
tected website to see your earnings state-

ment and the amount of your deposit.

IT'S MORE SECURE. Checks can get
lost or stolen in the mail — or lost or mis-
placed by you before you deposit them.

Our state-of-the-art security keeps all of

your information private and safe from
start to finish.
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NOW, THERE ARE TWO MORE
ADVANTAGES TO ADD TO THE LIST.

1)  Effective with your January business —
that is, the checks that are distributed
by February 10, 2010 — we will begin
deducting a $3.00 per check environ-
mental surcharge on all physical
checks we have to mail out to our rep-

resentatives.

By switching to Direct Deposit, you
avoid this surcharge.

2) Also effective with January business,
we will stop mailing out any checks
that, after deductions, do not total at
least $23.00 ($20.00 after the $3.00
environmental surcharge is deducted).
Monthly checks for less than $23.00
will be held for mailing until the cumu-
lative total reaches $23.00.

By switching to Direct Deposit, you
can continue to receive your funds
every month (regardless of amount)
and avoid the surcharge.
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To set up Direct Deposit, simply log in to
your Juice Plus+® Virtual Office. If you are
not already taking advantage of Direct
Deposit, you will be given the opportunity
to enroll when you log in. You can also
enroll or edit your Direct Deposit informa-
tion at any time under Personal
File>Personal Profile>Edit Personal

Information.

Upon enrolling in Juice Plus+®Direct
Deposit, you will receive an email from

us that your request is being processed.
You will know that your Direct Deposit has
been activated when you see a “deposit”
of $0 on your bank statement. The timing
of this process varies by bank and often

takes from two to four weeks.

Do yourself and the environment a favor:
sign up for Direct Deposit of your Juice

Plus+® check.
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Share the healthful Juice Plus+® message
and inspire others to do the same
with these great new support materials.

Fueling and Training
for Peak Performance

Audio CD,
featuring Jack Medina

Veteran trainer Jack Medina shatters myths
about proper training techniques — and
emphasizes the critical importance of good
nutrition — in his audio presentation about
training and fueling for peak performance.
This is an updated version of Jack's popu-
lar Run Faster! Jump Higher! CD — espe-
cially relevant to coaches, athletes, and

parents of young athletes.

(Sold in packs of 10 for $15.00)

Professional Support
Program (PSP) Brochure

Our new Professional Support Program
(PSP) brochure helps you and your team
members share the Juice Plus+® Virtual
Franchise® with doctors and other health
professionals in your “warm market” in

simple, straightforward terms.

(Sold in packs of 10 for $10)

19

Capitalizing on the Coming
Wellness Movement

Audio CD and booklet,
featuring Gordon Hester

Business consultant Gordon Hester
explains why Juice Plus+® is ideally posi-
tioned to benefit from the fundamental
changes in healthcare and the resulting
expansion of the wellness industry that

lie ahead.

(Sold individually for $3.00 each)

These and other Juice Plus+®, Juice Plus+®
Virtual Franchise®, and Juice Plus+®
Children’s Health Study materials are
available through Promo Plus+ at
www.nsapromoplus.com or by calling
888-552-8200.
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Juice Plus+® Virtual Franchise® News

DR. WILLIAM SEARS BRINGS PRIME TIME HEALTH
TO PHOENIX LEADERSHIP CONFERENCE IN APRIL
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William Sears, MD
with Martha gears, RN
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“America’s Pediatrician” William Sears,
M.D. is focusing on the other end of the
age spectrum in his soon-to-be-released
book Prime-Time Health.

"My wife, Martha, defines prime-time as
"the second-half of life,” Sears explains. “I
consider it a time when the kids are out of
the house — if not yet out of your pocket.”
Either way, “prime-time can be the best
part of your life,” he continues. “My new
book contains all the health and wellness
advice | give my own children as they

reach middle age.”

And, yes, of course, that advice includes

Juice Plus+®.

Dr. Sears will bring his Prime-Time Health
plan to Phoenix, Arizona as part of our
Juice Plus+°® Spring Leadership
Conference, April 22-24, 2010.

The conference, which celebrates the 40th
birthday of NSA, will open with a very
exciting and informative Thursday Night
Prevention Plus+ meeting, featuring four
other health professionals who also
embrace and share Juice Plus+®: Richard
DuBois, M.D.; David Phillips, M.D.; Mitra
Ray, Ph.D.; and Tamara Sachs, M.D. Each
will talk about Juice Plus+® clinical research
from the standpoint of their respective

specialties.

David Phillips, M.D.

Mitra Ray, Ph.D.

Tamara Sachs, M.D.
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Mike Rayburn

Another very special guest will be Mike
Rayburn, “The World's Funniest Guitar
Virtuoso.” Mike is the most poplar enter-
tainer to ever be featured at our Elton’s
Awards. He'll be closing our Friday after-
noon session with a keynote address unlike
any you'll ever see. Mike uses his unique
guitar skills and hilarious songs to illustrate
three "tools” that you can use to step
beyond perceived limitations. “These tools
took me from playing for seven people in
a bar to playing in Carnegie Hall,” he

explains.

Conference tickets are only $100 when
puchased by Friday, April 9. (They're $125
at the door) Juice Plus+® travel partner
Travelennium has secured some great
hotel rates, and some attractive airfare dis-
counts as well. Call 800-347-5947 to order
your conference tickets; you can reach out
to Travelennium at 800-807-0761 or at

Travelennium.com.



TEAM BUILDING BONUSES
EXTENDED THROUGH
APRIL 30

Our Team Building Bonuses have proven so
popular and so effective that we've extend-
ed them through April 30, 2010.

The “10-1-10” Team Building Bonus is
designed to help new Juice Plus+® repre-
sentatives achieve the position of Virtual
Franchisee in their first 60 days. Those new
representatives who meet the 10-1-10
goals (see page 13) receive an additional
$250 bonus plus a free ticket to a Juice
Plus+® Leadership Conference. Their spon-

sors also receive a $250 bonus.

The “5-1" Team Building Bonus is
designed to help all Juice Plus+® represen-
tatives Virtual Franchisee and above contin-
ue their Juice Plus+® business momentum,
or generate new momentum, by meeting
our 5-1 goals every month (see page 13).
Those who do so earn a $100 bonus the
first month and an additional $200 each

consecutive month thereafter.

For complete details, including information
on how existing representatives can take
advantage of the “10-1-10" bonus, go to
the News section on the home page of
your Juice Plus+® Virtual Office.

To see how you and your team are pro-
gressing in terms of Team Building
Bonuses, you can access reports directly in
the Team Building Bonus section on the
home page of your Virtual Office. To see
how others are doing throughout North
America, check out the latest Juice Plus+®
Awards bulletin on your Virtual Office under
Tools>NSAwards.
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CHANGES TO CHILDREN'S
HEALTH STUDY IN 2010

We're making two changes to the Children’s
Health Study (CHS) program for 2010.

First, beginning with orders processed on
Friday, January 1, we will begin to charge
$1.75 a month shipping and handling on
each carton of free product sent to child

and teen participants in the program.

JUICE PLUS+° VIRTUAL FRANCHISEE

NO MORE “"SUMMER
SURCHARGE"

There's another key difference between JP+
Gummies® and our new Juice Plus+®

Chewables: there will no longer be an added
“summer surcharge” attached to shipments

between May 15 and September 15.

Beginning in 2010, Juice Plus+® Chewables
shipments all year long will reflect our stan-

dard shipping and handling charges, with

Second, beginning with orders processed
on Tuesday, February 23, 2010, all child
participants currently receiving either JP+
Gummies® or Juice Plus+® Chewables as
their free product will begin to receive our

new Juice Plus+® Chewables instead.

“For 10 years, we've held the line on charg-
ing shipping and handling on the free CHS
product — despite steadily increasing under-
lying costs and significant expansions of the
Health Study itself,” explains CHS Executive
Director Linda Cole. “We are simply no
longer able to do so. We're extremely
pleased, however, that we are adding new

Chewables to the program.”

Both of these changes have already been

communicated to CHS families.
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no summer surcharge.

"We'll continue to ship the Chewables in
protective packaging during the summer
months,” explains Liza Pepple, Manager of
Product and Development for Juice Plus+®,
who led an effort to reduce the cost and
environmental impact of the protective
summer packaging. “We were able not
only to meet our cost and environmental
objectives, but also to actually improve the
insulation value of the protective packaging

in the process.”
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New Year’s Resolution: Attend a
Juice Plus+® Boot Camp near you.

.....................................................................................................................................

Every year, thousands of
Juice Plus+® representatives
and team leaders attend one
(or more) of the numerous
Juice Plus+® “Boot Camps”
held across North America
throughout the year.

This should be the year that
you resolve to do the same.

“At our Boot Camps, you get to hear
directly from some of NSA's most accom-
plished and experienced leaders in a
small-group setting,” explains Randy
Mathews, Vice President of U.S. Sales.
"You also get the opportunity to swap
ideas and develop relationships with other
highly-motivated people like yourself who
want to succeed in the Juice Plus+® busi-
ness — or build even further on their cur-

rent success.

"Our business is very simple,
and we offer a number of ~ }
great training tools,”
Mathews continues. “But
there's just no substitute for
the added inspiration and

special sense of excitement

o
v

Hawaii

.............................................

British Columbia

California

i and belief that you get from attending live
Juice Plus+® business events such as our
Boot Camps.”

i We believe in this so strongly, in fact,

that every new Juice Plus+® Senior Sales
Coordinator receives a one-time, $200

¢ credit toward attending the Boot Camp of
his or her choice. And, like most things
Juice Plus+®, our Boot Camps are not only
informative, but also fun — featuring good
i times, good food, and good friends along
with all the training.

i More and more Juice Plus+°® teams are
jumping on the Juice Plus+® Boot Camp

i bandwagon, either by hosting boot camps
of their own or by encouraging their team
¢ members to attend one. They're conduct-
ed in a variety of locations across North

i America. Check out the map below:
there’s probably a Juice Plus+® Boot Camp

¢ being held near you sometime next year.

Alberta

Saskatchewan

7
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i To find out more about Juice Plus+® Boot
Camps and why you should attend one,
please talk with your sponsor or another
“upline” team member, or contact

i Distributor Support at 901-850-3000

or at Support@JuicePlus.com.

To learn more about specific boot camp

i events — including contact and registration
information — go to Events>Events

i Schedule in your Juice Plus+® Virtual
Office (JuicePlusVirtualOffice.com) and

choose “"Boot Camp” as “Type of Event.”

.......................................................................................................................
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15-17
15-17
22-24
28-30

December

SCHEDULED FOR 2010

! JANUARY

Orange Blossom Boot Camp ... .Orlando, FL
LABootCamp ................ Universal City, CA
Las Vegas Boot Camp .......... Las Vegas, NV

Peachtree Boot Camp .......... Peachtree City, GA

{ FEBRUARY

13-15  Spiritof Aloha . ................ Honolulu, HI
18-20  Winterfest Boot Camp .......... Reno, NV
19-20  Kentucky Lakes Boot Camp . . .. .. Gilbertsville, KY
19-21  Padgett Boot Camp ............ Waynesboro, GA
: MARCH
19-20  Blue Bonnet Boot Camp ........ Round Rock, TX
19-21 Swamp Stomp Boot Camp ...... Eunice, LA
26-28  Swan Lake Boot Camp .......... Plymouth, IN
26-28  Beavertail Boot Camp .......... Banff, BC
{ APRIL
: 22-24  Juice Plus+® Spring Conference . . .Phoenix, AZ
MAY - NO BOOT CAMPS
: JUNE
: 4-6 New Jersey Boot Camp ......... Wall Township, NJ
4-6 Padgett Boot Camp . ........... Waynesboro, GA
4-6 Ontario Fest Boot Camp ........ Ontario, BC
4-6 Branson Boot Camp .. .......... Branson, MO
11-13  Buckeye BootCamp ........... Mt. Sterling, OH
11-13  Ultimate Communications . ... ... San Diego, CA
17-19  Dutch Treat Boot Camp ......... Lancaster, PA
25-26  Summer in the Rockies ......... Keystone, CO
25-26  Chicago Fest Boot Camp ....... Chicago, IL
25-27  Sierra Blanca Boot Camp ... ... .. Ruidoso, NM
:JuLy
: 16-18  North Coast Boot Camp ........ Cleveland, OH
16-18  Pacific Spirit Boot Camp ........ Squamish, BC
22-25  Seattle Summit Boot Camp . ... .. Leavenworth, WA
23-25  Atlanta Fest Boot Camp ........ Atlanta, GA
23-25  Traverse City Nat'l| Cherry Fest .. .Traverse City, Ml

90 00000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000

2009

JUICE PLUS+° VIRTUAL FRANCHISEE

AUGUST
6-8 Minnesota Northern Lights ... .. Otsego, MN
6-8 New England Summer Fest . . .. .. Endicott, MA
20-22  NMD Boot Camp .............. San Diego, CA
27-29  Mountain Lakes Boot Camp .. ... Pembroke, VA
SEPTEMBER - NO BOOT CAMPS
OCTOBER
21-23  Juice Plus+® Fall Conference . . . .. Nashville, TN
NOVEMBER
19-21  Padgett BootCamp ............ Waynesboro, GA
TBD S. Padre Island Boot Camp ... ... S. Padre Island, TX
DECEMBER
4-6 Branson Boot Camp . ........... Branson, MO

....................................................................................................................................................................................
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Guess who’s turning 4o
next year.

In 1970, a young schoolteacher named North America’s greatest resort destina-
Jay Martin followed his entrepreneurial tions. We're planning the biggest birth-
heart — and a company he named NSA day party that Juice Plus+® Nation has
was born. Jay’s vision was not just to ever seen, and we think YOU should
realize his own business dreams, but be there.

also to provide a vehicle for others to .
Tickets are only $100 when purchased

by Friday, April 9. (They're $125 at
Forty years later, both Jay and his com-  the door.) Juice Plus+® travel partner

do the same.

pany are still going strong. Travelennium has secured some great
hotel rates, and some attractive airfare
discounts as well. Call 800-347-5947

to order your conference tickets;

NSA is showing no signs of a “midlife”
crisis, either. The company continues to

grow despite a challenging economy; )
you can reach out to Travelennium at

it's still debt-free; and, most important i
800-807-0761 or at Travelennium.com.

of all, it has Juice Plus+® as its flagship
product. Come help us blow out the birthday
candles April 22-24 in Phoenix. We

In fact, we'd argue that NSA is just get- ) )
promise our usual conference mix of

ting ready to enter the “prime time” of ) o o
) ) i fun, education, recognition, and inspira-
its business life. ) ) ] ) )

tion — with a special emphasis on just
Come help us celebrate the 40th birth- ~ how far we've come over the past 40
day of NSA at our Spring Leadership years, and the even brighter future that

Conference in Phoenix, Arizona, one of lies ahead.

JUICE PLUS+° SPRING LEADERSHIP CONFERENCE
APRIL 22-24, 2010 « PHOENIX, ARIZONA
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